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Создание контура печатной платы в 
среде Altium Designer

1. Создание контура печатной платы с помощью 
PCB Board Wizard .



Открыть PCB Board Wizard с 
помощью команда PCB Board Wizard 
в панели File. Если эта опция не 
отображается на экране, 
необходимо закрыть некоторые из 
вышерасположенных разделов, 
нажав на значок со стрелкой.



Установите 
единицы 
измерения Metric . 
Altium Designer 
одинаково хорошо 
работает как с 
метрической, так и 
с дюймовой 
системой мер, 
причем 
заложенная 
точность на два 
порядка выше, чем 
в системе P-CAD, а 
переключение 
системы единиц 
может быть 
выполнено в любой 
момент работы над 
проектом. Нажмем 
кнопку Next



На третьей 
странице мастера 
позволяет выбрать 
из списка 
существующих 
шаблонов 
стандартных 
промышленных 
печатных. В данном 
примере мы 
зададим 
собственные 
размеры платы, для 
чего выбираем из 
списка Custom 
(пустой бланк) и 
нажимаем «Next».



Так как в 
предыдущем меню 
из списка было 
выбрано Custom в 
четвертом окне 
нужно задать 
форму и размеры 
будущей платы.



В правой части 
данного окна 
выбирается слой на 
котором будет 
размещаться контур 
платы (Dimension Layer). 
Задается толщина 
линий прорисовки 
границы платы 
(Boundary Track Width) и 
размеров (Dimension 
Line Width), а также 
отступ от края платы 
(Keep out Distance From 
Board Edge).







На следующем 
шаге необходимо 
указать количество 
сигнальных слоев, 
а также внутренних 
слоев питания и 
заземления. В 
нашем случае 
будет только два 
сигнальных слоя, 
поэтому в поле 
Signal Layers следует 
ввести число 2, а в 
поле Power Planes — 
число 0. Для 
продолжения 
нажмем кнопку 
Next.



Далее следует 
определить тип 
переходных 
отверстий. Так как 
мы проектируем 
простую 
двухстороннюю 
плату, то выберем 
тип Thruhole Vias only 
(сквозны 
переходные 
отверстия).

Заметим, что система Altium Designer позволяет использовать на многослойных 
платах слепые и глухие переходные отверстия, в том числе и по технологии 
Microvia. Для использования слепых и глухих переходов в текущем окне 
следует выбрать опцию Blind and Burier Vias only.



При выборе опции Through-hole components (преобладает монтаж в отверстия) 
ниже указывается допустимое число проводников между смежными контактными 
площадками. Если была выбрана опция Surface-mount components (преобладает 
поверхностный монтаж), ниже указывается разрешено или нет двустороннее 
размещение SMD-компонентов

В следующем окне 
необходимо 
выбрать 
преобладающую 
технологию 
монтажа 
компонентов 
(поверхностный или 
монтаж в 
отверстия).



В следующем окне 
можно настроить 
некоторые 
параметры, которые в 
дальнейшем будут 
преобразованы в 
правила 
проектирования.

Все задаваемые размеры, для наглядности, отображаются 
рисунками справа от значения. Здесь задаются минимально 
допустимые:
•ширина проводника (Track Size)
•диаметр площадки переходного отверстия (Via Width)
•диаметр переходного отверстия (Via Hole Size)
•зазор между проводниками (Clearance).



Последнее диалоговое окно сообщает, что создание заготовки платы 
завершено. Нажимаем кнопку «Finish» и редактор печатных плат покажет новый 
файл PCB с именем PCB1.PcbDoc и базовым количеством настроек.





В рабочей области по умолчанию будет 
отображаться белый лист с пустой 
платой (черная область с сеткой). Что бы 
отключить отображение белого листа 
необходимо зайти Design » Board Options и 
в диалоговом окне снять галочку 
напротив пункта Display Sheet.



Для отображения платы, во всю 
рабочую область, можно 
использовать функцию 
View » FitBoard
 [горячие клавиши: V> F. 
После чего плата будет 
максимально приближена в 
границе рабочей области.



Создание контура печатной платы в 
среде Altium Designer

2. Создание простого контура печатной платы 
вручную.



Первый этап:
создание документа 
PCB.PcbDoc в проекте 
печатной платы 
PCB_Project.PrjPcb

I

II



Второй этап:
резервирование слоя для 
контура печатной платы. 
Слой должен содержать 
ТОЛЬКО ИНФОРМАЦИЮ О 
КОНТУРЕ и более не 
использоваться!!!!Вызываем окно настройки слоев на печатной плате

Либо с 
помощью 
горячей 
клавиши 
«L»





Перечень слоев в строке состояния до 
редактирования

Перечень слоев в строке состояния после 
редактирования



Третий этап:
редактирование настроек документа 
PCB.PcbDocВызов окна настроек рабочего пространства документа 

PCB.PcbDoc: 
щелчок правой кнопкой мыши по рабочему пространству=>Options=>Board 
Options. По аналогии с ранее изученными настройками рабочих пространств 
библиотек и документа схемы. 

Либ
о

Design=>Board Options.



В данном окне не забываем 
менять систему единиц 
измерения на метрическую

Оставляем видимым шаг 
сетки



Меняем шаг координатной сетки на более удобный при проектирования

Вызываем окно настроек шага 
координатной сетки нажатием 
клавиши «G», либо щелчок правой 
кнопкой мыши по рабочему 
пространству=>Snap Grid



Четвертый этап:
Отрисовка контура

Set Origin – устанавливаем 
начало координат на 
пересечении линий сетки 
рабочего пространства.

Для формирования контура 
заданного размера и формы 
необходимо воспользоваться 
чертежными инструментами во 
вкладке PLAСE, 
могут потребоваться также 
инструменты типа ARC для 
построения окружностей и дуг.
Shift+пробел – ортогональный 
режим построения линий.



Необходимый 
контур

Режим 
3D

На данном этапе 
контур сформирован, 
но AD воспринимает 
его как набор линий, а 
не как отдельную 
область.



Пятый этап:
Создание по контуру формы 
печатной платы
Выделяем созданный 
контур, а далее 

Design => Board Shape 
=> Define from 
selected objects 



3D режим просмотра заготовки печатной 
платы

Переход из 2D 
режима в 3D 
режим 
осуществляет
ся клавишами
 2 и 3 на 
клавиатуре



Изменение контура печатной платы можно проводить на 
любом этапе проектирования. 
Для этого необходимо отредактировать нужным образом 
контур => выделить полученный контур => Design => Board 
Shape => Define from selected objects (повторение прошлой 
команды)



Особенности формирования 
контура вручную:

1. Толщина линий контура на 
данном этапе не имеет 
значения.

Главное слой!!!!

2D 3D



2. Контур должен быть замкнут.

В данном случае использована 
очень мелкая сетка и жирная 
линия контура, визуально 
разрыв не виден, но при 
команде выделить полученный контур => 

Design => Board Shape => Define from 
selected objects 

Появляется окно с 
ошибкой

При игнорировании
Создается сложный вырез и к 
толщине платы прибавляется 
толщина линии 

2D 3D



3. Контур должен быть одинарный.

Визуально наложение линий 
друг на друга не заметно, но при 
двойном клике на линию будет 
появляться окно с выбором 
объекта редактирования
выделить полученный контур => 
Design => Board Shape => Define from 
selected objects 

Появляется окно с 
ошибкой

При игнорировании
Создается контур по 
внешней линии с 
дополнительными 
скруглениями

2D 3D



4. Внутренние углы на заготовке 
должны формироваться с 
помощью дуг нужного 
диаметра,  иначе 
производителю необходимо 
будет предоставлять 
дополнительную информацию 
о диаметре скругления, либо 
скругление будет 
сформировано по 
произвольной форме.



После данной операции обязательно редактируем 
контур!!! Либо выполняем ее до обрезки.

выделить полученный контур => Design => Board Shape => Define from 
selected objects



5. Вырезы в печатной плате

Формируется контур выреза с 
помощью чертежных 
инструментов в панели 
PLANE

Данный вариант 
приемлем для 
производителя, но 
недостаточен для 
проектировщика, так как 
область ограниченная 
внутренней окружностью 
не является для AD 
отдельным контуром.



Конвертируем контур в вырез 
печатной платы
Выделяем контур 
будущего
 выреза =>Tools=>Convert=>
Create Board Cutout from 
Selected Primitives



Сформированный контур печатной платы в 
2D и 3D режимах



Возможно перемещение отверстия при 
необходимости

При этом возникает возможность перемещения 
отдельно региона и отдельно самого контура. 



Во избежание случайного редактирования контура 
можно воспользоваться командой Loced для каждого 
примитива контура.



После полного 
редактирования слой, 
на котором изображен 
контур печатной 
платы (Mechanical 5) 
скрыть.



Создание контура печатной платы в 
среде Altium Designer

3. Создание сложного контура печатной платы на 
базе STEP-модели.



Проектируем размеры и форму будущей заготовки для 
печатной платы при помощи чертежных пакетов САПР



Сохраняем деталь 
заготовке в формате 
Step модели (*.step, *.stp).

Деталь с геометрией 
любой сложности в 
формате STEP может 
быть сформирована в 
любой из программ 
твердотельного 
моделирования 
(SolidWorks, ProE, Компас 
и т.д.).

Пакет  Altium Designer 
поддерживает оба 
формата STEP (AP203 и 
AP214), однако следует 
помнить, что в формате 
STEP AP203 не 
сохраняется 
информация о цвете 
модели.



1. Создаем файл PCB.PcbDoc для 
печатной платы
2. Меняем шаг сетки и устанавливаем 
метрическую систему координат
3. Выполняем команду Place=>3D Body, 
которая позволяет добавить к проекту 
3D объект. В данном случае заготовку 
печатной платы.
Вид окна 3D Body в более свежих 
версиях AD имеет небольшие различия в 
оформлении, но функционал остался 
прежним.



Данное окно позволяет не только 
импортировать файлы из других 
программ, но и создавать в 
среде AD некоторые 
примитивные 3D объекты.

Выбираем Generic STEP Model.

Выбираем слой, на котором 
будут храниться проекции 3D 
тела и слой для проектирования.

Embed STEP Model – встроенная 
модель (доступ к 
редактированию 3D заготовки 
возможен только в среде AD)

Link To STEP Model – ссылка на 
STEP-файл (при изменении в 
геометрии модели с помощью 
программы, в которой ее 
создали происходит 
автоматическое обновление ее 
геометрии AD)



Выбираем 
Embed STEP Model, после чего 
появиться возможность открыть 
файл в формате STEP требуемой 
заготовки.
После этого снова откроется окно 
3D Body. 
В поле Identifier панели Properties 
появится имя документа 
заготовки.
Подтверждаем выполнение 
команды кнопкой ОК.



После нажатия 
кнопки ОК окно 3D 
Body закрывается. 
За мышью 
прикрепляется 
контур 3D  тела, 
который 
необходимо 
разместить в 
свободном месте на 
рабочем 
пространстве. 

Далее снова 
откроется окно 3D 
Body, для 
перепроверки 
настроек 
размещения 
объекта, выбираем 
Cancel.



Для дальнейшего редактирования размещения заготовки 
необходимо перейти в 3D режим (клавиша «3» на клавиатуре)



Выбираем команду 
Design=>Board Shape=>Define from 
3D body
Данная команда доступна 
только в 3D режиме.Выбираем 3D тело щелчком 
левой кнопки мыши, которое 
будем проецировать, в данном 
случае оно одно, но могут быть 
варианты и с несколькими 
телами.

Выбираем плоскость 
проецирования щелчком левой 
кнопки мыши также.
При не совпадении плоскости  
тела с плоскостью рабочего 
пространства появляется окно, 
в котором необходимо 
подтвердить изменение 
положения тела в рабочем 
пространстве по верхнему или 
нижнему слою, выбираем 
верхний (top)



Происходит 
автоматический поворот 3D 
объекта и ориентирование 
по рабочему полю.
Снова повторяем команду 
Design=>Board Shape=>Define 
from 3D body.
После этого AD создает 
контур платы и появляется 
окно:

Оставляем подтверждение 
команды - скрыть 3D тело и 
отключить проверку на зазоры 
компонентов



Контур платы 
перестроен, 
изменился ее цвет.

Тень от прошлой 
заготовки.
Что бы тень пропала 
вернитесь в режим 
2D, а затем снова в 
3D, тень исчезнет и 
останется только 
ваша новая заготовка



Переходим к этапу редактирования полученного 
контура. 
Для этого переходим снова в режим 2D. 
Скрываем слой Mechanical 2.

Проецируем в слой Mechanical 5 контур печатной 
платы (это необходимо для возможности 
передачи контура печатной платы 
производителю).
Форма контура сложная и ее сформировать 
вручную проблематично, поэтому выполняем 
команду
Design=>Board Shape=> Create Primitives From Board 
Shape
Она в автоматическом 
режиме создает 
примитивы из уже 
существующей печатной 
платы



Слой, в котором 
созданы 
примитивы и 
ширина линии

Включить вырезы 
в контуре

Добавить стек

Настройки 
трассировки

Удалить все, что 
находилось в 
данном слое до 
этого



Контур в местах сложной 
формы  имеет составную 
конфигурацию и состоит из 
множества отдельных 
мелких отрезков



Из контура в плату 
перешли крепежные 
отверстия, той формы и 
размера, что и в 
заготовке, необходимо 
открыть их свойства 
(двойной щелчок левой 
кнопкой мыши по 
отверстию) и убрать 
металлизацию (убрать 
галочку в позиции Plated). 
При необходимости 
возможно изменить их 
размер.



Также был сформирован внутренний вырез 
аналогично с проектированием вручную он 
имеет тип регион



При попытке 
перемещения одного 
отверстия происходит 
перемежение всех 
отверстий и вырезов 
одновременно, в 
автоматическом режиме 
создается союз 
отверстий.



При необходимости переместить 
только одно или некоторые из 
отверстий:
Щелчок правой кнопки мыши по 
отверстию=>Unions=>Break objects 
from Union



Даннуя заготовка готова.

Устанавливаем начало координат по аналогии с 
ручным созданием.

Сохраняем контур и скрываем слой Mechanical 5 
для запрета случайного редактирования, 
настраиваем стек печатной платы.



ИТОГ:
Что далее с этим делать??



Передача информации об 
элементах и связях между 
ними из файла схемы в 
файл печатной платы в 

одном проекте











Спасибо за внимание!


